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SOMA NETWORKS INC. ENDUSER PRODUCT LICENSE AGREEMENT

THE SOMAPORT™ SUBSCRIBER TERMINAL AND PROVIDED SOFTWARE CONTAIN CERTAIN 
COMPUTER PROGRAMS AND OTHER PROPRIETARY MATERIAL OF SOMA NETWORKS INC. OR 
LICENSED TO SOMA NETWORKS, INC., THE USE OF WHICH IS SUBJECT TO THIS 
AGREEMENT. BY: (A) SIGNING AN AGREEMENT FOR SERVICE WITH YOUR SERVICE 
PROVIDER; (B) OPENING THE SEALED ENVELOPE CONTAINING THE SOMAPORT; OR (C) 
USING THE SOMAPORT, YOU ASSENT TO AND ACCEPT THIS ENDUSER PRODUCT LICENSE 
AGREEMENT. IF YOU DO NOT AGREE WITH ALL THE TERMS OF THIS AGREEMENT YOU 
MUST RETURN THIS PRODUCT (WITH THE ENVELOPE STILL SEALED), ALL MANUALS AND 
DOCUMENTATION, ANY SOFTWARE PACKAGES PROVIDED WITH THE SOMAPORT AND 
PROOF OF PAYMENT TO THE PLACE YOU OBTAINED THEM FOR A FULL REFUND WITHIN 
THIRTY (30) DAYS OF FIRST ACQUIRING THE SOMAPORT, OTHERWISE YOU ARE DEEMED TO 
HAVE ACCEPTED AND AGREED TO THESE TERMS AND CONDITIONS. UNAUTHORIZED 
REPRODUCTION, DISTRIBUTION, DECOMPILATION OR OTHER REVERSE ENGINEERING OF 
THIS PRODUCT INCLUDING ITS HARDWARE AND/OR SOFTWARE, OR ANY PORTION OF IT, IS 
PROHIBITED AND MAY RESULT IN SEVERE CIVIL AND CRIMINAL PENALTIES, AND WILL BE 
PROSECUTED TO THE MAXIMUM EXTENT POSSIBLE UNDER THE LAW.

1. GRANT OF LICENSE: Subject to the terms of this Enduser Product License Agreement (the “Agreement”), 
SOMA Networks, Inc. (“SOMA”) grants you (the “Licensee”) a non-sub-licensable, non-exclusive right 
(“License”) to use the Product. “Product” means, collectively, the Software and the provided hardware, and 
specifically the SOMAport™ subscriber terminal and its accessories, if any, together with documentation 
provided to you by SOMA or your service provider. “Software” means, collectively, the version of the SOMA 
software program in object code format and all updates to that program distributed to you by SOMA, directly or 
indirectly, by any means and includes any firmware provided to you with the Product. You have no right, unless 
otherwise explicitly permitted, to receive any source code or design documentation relating to the Product. 
SOMA retains ownership of all Software copies. The Software and this License is only provided to you to be used 
in conjunction with the SOMAport provided to you by SOMA or your service provider when you subscribed to 
services that utilize the SOMA wireless air interface technology and is not licensed to you to be used for any other 
purpose. 

2. RESTRICTIONS: Except as reasonably required to use the Product strictly in accordance with the License and 
this Agreement, you may not copy any Software. Licensee shall not (and shall not allow any third party to): (I) 
decompile, disassemble, or otherwise reverse engineer or attempt to reconstruct or discover any source code or 
underlying ideas or algorithms or file formats or programming or interoperability interfaces of the Product by any 
means whatsoever; (II) remove any Product identification, copyright or other notices; (III) modify, incorporate 
into or with other software or create a derivative work of any part of the Software or Product; or (IV) modify or 
otherwise alter the operation of the Product. Various components, functions, routines and/or portions of the 
Product may be protected by Intellectual Property Rights (“IPR”) including, but not limited to, designs, 
copyrights, trade secrets and one or more patents or pending patent applications. Licensee is licensed under such 
IPR, if any, only to the extent that such a license is required by the licensee to operate the Product in the manner 
intended by SOMA. No other rights are granted under such IPR and no right to repair or replace the Product is 
intended or provided and specifically, no right of reconstruction, substitution or repair is provided.
 3. TERMINATION: This License is effective until terminated. This License will terminate automatically if you 
fail to cure any material breach, as determined at the sole discretion of SOMA, of this Agreement within thirty 
(30) days after such breach first occurs (or immediately in the case of a breach of § 2). Upon termination, you 
shall immediately cease all use of the Product and return all of the Product including Software, hardware, 
manuals, documentation of any kind accompanying Product to the place where you first obtained such Product 
or such other location as may be designated from time to time. Except for this License and except as otherwise 
expressly provided herein, the terms of the Agreement shall survive termination.
3
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4. WARRANTY DISCLAIMER: THE SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF 
ANY KIND INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. FURTHER, SOMA DOES 
NOT WARRANT, GUARANTEE OR MAKE ANY REPRESENTATIONS REGARDING THE USE, OR 
THE RESULTS OF THE USE, OF THE PRODUCT OR WRITTEN MATERIALS IN TERMS OF 
CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. YOUR SERVICE PROVIDER MAY 
PROVIDE FURTHER WARRANTY COVERAGE FOR YOU.

5. LIMITATION ON REMEDIES AND DAMAGES: SOMA SHALL NOT BE RESPONSIBLE OR LIABLE 
UNDER ANY CIRCUMSTANCE WITH RESPECT TO ANY SUBJECT MATTER OF THIS ENDUSER 
PRODUCT LICENSE AGREEMENT UNDER ANY CONTRACT, NEGLIGENCE, STRICT LIABILITY 
OR OTHER THEORY: (A) FOR LOSS OR INACCURACY OF RECORDS OR DATA OR (EXCEPT FOR 
RETURN OF AMOUNTS PAID TO SOMA THEREFOR) COST OF PROCUREMENT OF 
SUBSTITUTE GOODS, SERVICES OR TECHNOLOGY, (B) FOR ANY SPECIAL, INDIRECT, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF 
PROFITS, LOSS OF SAVINGS, (C) THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES, OR (D) 
FOR ANY MATTER BEYOND THE REASONABLE CONTROL OF SOMA EVEN IF SOMA AND / OR 
ITS SUPPLIERS IS/ARE INFORMED OF THEIR RESPONSIBILITY. SOME JURISDICTIONS DO NOT 
ALLOW FOR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. 

6. UPDATES TO SOFTWARE and TRANSMISSION OF PERSONAL DATA: You consent to receive and 
employ updates to Software, without requiring further notice to you, that may occur from time to time, as may be 
necessary, as determined at the sole discretion of SOMA and/or your service provider, for the use of Product by 
you and for the efficient utilization of services as may be purchased or subscribed to by you from your service 
provider. You also agree to the application of the terms of this Agreement to any and all such updates. You accept 
and acknowledge that Software shall be able to transmit such data as is authorized by your service provider in 
order to allow for the utilization of services subscribed or purchased by you in order to allow for the billing of such 
services or as may be necessary by law.
7. MISCELLANEOUS: This Agreement and the License provided by this Agreement are not assignable or 
transferable by you without the prior written consent of SOMA. Any attempt by you to do so shall be void and 
void this License. Any notice, report, approval or consent required or permitted hereunder shall be in writing. If 
any provision of this Agreement shall be adjudged by any court of competent jurisdiction to be unenforceable or 
invalid, that provision shall be limited or eliminated to the minimum extent necessary so this Agreement shall 
otherwise remain in full force and effect and enforceable. This Agreement shall be construed pursuant to the laws 
of the United States of America and the State of California and without regard to conflicts of laws principles 
thereof. If successful in any action to enforce this Agreement, SOMA shall be entitled to recover costs and 
expenses including, without limitation, attorney's fees. The parties agree that a material breach of this Agreement 
would cause irreparable injury to SOMA, or its suppliers, for which monetary damages would be an adequate 
equitable relief and SOMA shall be entitled to any other remedies it may have available hereunder or at law. Both 
parties agree that this Agreement is the complete and exclusive statement of mutual understanding of the parties 
and supersedes and cancels all previous written and oral agreements and communications relating to the subject 
matter of this Agreement. BOTH YOU AND SOMA AGREE AND ACKNOWLEDGE THAT SOMA 
RESERVES THE RIGHT TO AMEND THE TERMS AND CONDITIONS OF THIS AGREEMENT 
WITHOUT FURTHER NOTICE TO YOU OTHER THAN PROVIDING TO YOU THE AMENDED 
TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU DO NOT ACCEPT THE AMENDED 
TERMS AND CONDITIONS AS PROVIDED TO YOU BY SOMA, THIS LICENSE SHALL 
TERMINATE IMMEDIATELY. ALL USE OF THE SOFTWARE AND ANY SERVICES SUPPORTED BY 
THE PRODUCT AND SOFTWARE MAY CEASE OR BE CAUSED TO BE CEASED WITHOUT ANY 
LIABILITY TO YOU BY SOMA AND YOU SHALL RETURN ALL PRODUCT HARDWARE, MANUALS, 
DOCUMENTATION OF ANY KIND ACCOMPANYING SOFTWARE TO THE PLACE WHERE YOU 
FIRST OBTAINED SUCH HARDWARE, MANUALS, DOCUMENTATION AND SOFTWARE.
4
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IMPORTANT SAFETY INSTRUCTIONS

Installation
Read instructions — Read and follow all of the safety and operating 
instructions before operating the SOMAport. 

Retain instructions — Retain the safety and operating instructions for 
future reference.

Heed warnings — Adhere to all warnings on the SOMAport and in the 
operating instructions.

Ventilation — Slots and openings in the SOMAport housing provide 
ventilation, ensure its reliable operation, and protect it from 
overheating. Do not block or cover these openings. Do not place the 
SOMAport in a built-in installation such as a bookcase or rack unless 
there is proper ventilation or the installation instructions have been 
adhered to.

Power sources — Use only the type of power source indicated on the 
label. If you are not sure of the type of power supplied to your home, 
consult your product dealer or local power company. 

Grounding and polarization — The plug for the power cord on the 
SOMAport fits into the power outlet only one way. If you are unable to 
insert the plug fully into the outlet, contact your electrician to replace 
your outlet. To prevent electric shock, do not use this plug with an 
extension cord or outlet unless you can fully insert the blades without 
blade exposure. Do not defeat the safety purpose of this plug.

Power-cord protection — Route power-supply cords so that they are 
not likely to be walked on or pinched by items placed upon or against 
them. Watch for wear in the cord at the plug and socket. 

Accessories — To avoid personal injury or damage to the SOMAport, 
do not place it on an unstable cart, stand, tripod, bracket, or table. 
5
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Attachments — Do not use attachments with the SOMAport that have 
not been recommended in this guide as they may cause hazards.

Water and moisture — Do not use the SOMAport near water or 
moisture. 

Maintenance and Servicing
Cleaning — Unplug the SOMAport from the wall outlet before 
cleaning. Do not use liquid or aerosol cleansers. Use a dry cloth to wipe 
the outside of the unit. 

Servicing — Do not attempt to service the SOMAport yourself as 
opening or removing covers may expose you to dangerous voltage or 
other hazards and may void the warranty. There are no user-serviceable 
parts inside. Refer all servicing to qualified service personnel. 

Conditions requiring service — Unplug the SOMAport from the wall 
outlet and refer servicing to qualified service personnel under the 
following conditions:

The power supply or cord is damaged.

Liquid has been spilled on the SOMAport or it has been exposed 
to water.

An object has fallen into the SOMAport.

The SOMAport does not function normally even though you have 
adhered to the operating instructions and have made adjustments 
to only those controls covered by the operating instructions. 

The SOMAport exhibits a distinct change in performance.

Alerts Used in This Guide 

WARNING: Where you see this symbol and the WARNING heading,
strictly follow the instructions to avoid personal injury or damage to the
product.
6
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REGULATORY NOTICES

The SOMAport has been tested and found to comply with the limits for 
a Class B digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference 
will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, you can try to correct 
the interference by:

Relocating the SOMAport

Increasing the distance between the SOMAport and the device 
experiencing the interference

Connecting the equipment to an outlet on a circuit different from 
that to which the SOMAport is connected  

ATTENTION: Changes or modifications not expressly approved by SOMA
Networks for compliance could void the user's authority to operate the
equipment.

Declaration of Conformity

SOMA Networks, Inc.,
185 Berry Street, Suite 4600

San Francisco, CA 94107 U.S.A.
(415) 882-6500

declares under our sole responsibility that the product
SOMAport

complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) This device may not cause harmful 

interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation.
7
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This chapter provides an introduction to the SOMAport subscriber 
terminal. Please read this chapter to familiarize yourself with the features 
and operation of the device.
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OVERVIEW

The SOMAportTM subscriber terminal provides high-speed Internet 
access and telephone service. The SOMAport works like a cell phone, in 
that it communicates with your service provider’s network over the air 
and does not require a special wire connection or external antenna. 

Installation is easy. You simply plug-in the SOMAport and connect it to 
your computer using the provided Ethernet or USB cables. The 
SOMAport will automatically connect to your service provider and you 
can setup your account using a Web browser. 

If you are using your SOMAport to provide telephone service, you can 
connect ordinary telephones to it.

Internet Access
The SOMAport provides a high-speed, “always on” Internet 
connection, which means you can be connected to the Internet and still 
use your telephone.The SOMAport is designed to be left on–it should 
not be turned off when not in use.

Telephone Service
The telephone service provided by the SOMAport is separate from your 
land-line telephone service. The services to which you can subscribe may 
differ from traditional land-line services. Consult your wireless service 
provider for details. 
10
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THE FRONT PANEL

There are two lights on the front panel that indicate the state of the 
SOMAport: status and network.

Status Light
Network Light
11
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Status Light
The status light indicates whether or not the SOMAport is powered on 
and operating normally.  

Network Light
The signal strength light indicates if the SOMAport has located a 
basestation.  

State Description

Off The SOMAport is not receiving power.

Amber The SOMAport is booting and running its internal 
diagnostics.

Flashing amber The SOMAport is upgrading its software.

Green The SOMAport is powered and operating normally.

Red An error occurred. The SOMAport is not currently functional.

State Description

Off The SOMAport is not receiving power.

Amber The SOMAport is attempting to locate a basestation.

Flashing amber The SOMAport cannot locate a basestation.

Flashing green The SOMAport has located a basestation and is attempting 
to establish a connection.

Green The SOMAport has located a basestation and has 
established a connection.

Red An error occurred. The SOMAport is not currently functional.
12
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THE BACK PANEL

The jacks and ports for connecting other devices to the SOMAport are 
on the back panel, as shown below. 

Part Description

Ethernet port Use this port with the supplied Ethernet cable 
to connect the SOMAport to a computer or 
hub. This is the preferred type of Internet 
connection. 

USB port Use this port with the supplied USB cable to 
connect the SOMAport to a computer. This 
type of connection is intended for use with 
computers that do not have an Ethernet port. 

Telephone 
jacks

Use these jacks to connect telephones to the SOMAport. 

Power jack Use this jack to connect the power supply. 

Ethernet Port

USB Port

Power Jack

Telephone Jack (Line 2)

Telephone Jack (Line 1)
13
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THE INTERNAL ANTENNA

The SOMAport communicates with a cellular tower operated by your 
wireless service provider. The SOMAport contains an antenna that 
automatically steers itself toward the best signal when you plug in the 
SOMAport. It also periodically checks to see if the current antenna 
direction is optimal and adjusts automatically if required. So, if you 
move the SOMAport without unplugging it, and the antenna direction 
is no longer optimal, the SOMAport automatically steers the antenna to 
improve performance. 

WARNING: While this device is in operation, a separation distance of
at least 20 centimeters (8 inches) must be maintained between the
radiating antenna and any person exposed to the transmitter in order to
meet the FCC RF exposure guidelines. No change to the antenna or
device is permitted. Doing so may result in the installed system exceeding
RF exposure requirements. This device must not be co-located or
operating in conjunction with any other antenna or radio transmitter.
Installers and end users must follow the installation instructions provided
in this guide. 
14
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This chapter explains how to install the SOMAport and activate service. 
After following the procedures described in this chapter, your 
SOMAport should be fully functional.
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UNPACK THE SOMAPORT

Unpack the SOMAport and make sure you have all the pieces shown 
below. Find the SOMAport serial number on the bottom of the unit 
and write it down. You may need this number if you call for technical 
support. 

SOMAport Serial Number:________________________________

SOMAport Setup Guide

SOMAport

SOMAport 
USB Drivers CD

SOMAport Quick
Setup Card

Power Supply

 

USB Cable

Ethernet Cable
(straight-through) 
16
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CHOOSE THE BEST LOCATION

Although the SOMAport’s internal antenna is self-steering, you can 
optimize signal reception by following these recommendations when 
choosing a location: 

Allow at least 46 centimeters (18 inches) of space around the 
SOMAport. 

If your home or office has multiple floors, place the SOMAport on 
one of the upper floors, if possible. Avoid putting it in the 
basement. 

Place the SOMAport higher up in a room. For example, putting it 
on a desk or a shelf will give you a stronger signal than if you place 
it on the floor. 

Place the SOMAport near a window.

Avoid placing the SOMAport close to certain electronic devices, 
such as microwave ovens and computer monitors, as they can 
cause interference.
17
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POWER ON THE SOMAPORT

The SOMAport does not have a power switch. To turn it on, plug it 
into a power outlet. To turn it off, unplug it. 

To power on the SOMAport
1 Insert the connector on the power supply cord into the power jack on the 

back of the SOMAport. 

2 Insert the socket end of the power cord into the power supply’s receptacle.
3 Insert the plug end of the power cord into a three-prong grounded power 

outlet.
The light on the power supply turns on when it is receiving power. 

The SOMAport takes up to five minutes to start, acquire a signal, and connect 
to the network. Wait for the network light on the front panel to turn green before 
you attempt to use the SOMAport.

NOTE: If you ever need to disconnect the SOMAport, unplug the power cord 
from the wall power outlet first and then unplug the connector from the back 
of the SOMAport.   

WARNING: Use only the power supply and power cord that come with
the SOMAport. Using another power supply may damage your
equipment and might cause shock or electrocution. 

Grounded Power Outlet

Power Supply

Power Light
Power Jack

Power Cord
18
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CONNECT COMPUTER USING ETHERNET

If your computer has an Ethernet port, use the supplied Ethernet cable 
to connect your computer to the SOMAport. 

If your computer does not have an Ethernet port, use the USB cable 
instead. See “Connect Computer Using USB” on page 20 for more 
information. 

To connect a computer via Ethernet
1 Insert one end of the supplied Ethernet cable into the Ethernet port on the 

back of the SOMAport.
2 Insert the other end of the cable into the Ethernet port on your computer. 
19
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CONNECT COMPUTER USING USB

If your computer does not have an Ethernet port and it is running 
Windows 98SE, ME, 2000, or XP, you can use the supplied USB cable 
to connector your computer to the SOMAport.

NOTE: Ethernet is the preferred type of connection. The USB connection 
should only be used in computers that do not support Ethernet.

To connect a computer via USB
1 Insert the SOMAport USB Drivers CD into the CD-ROM drive on the 

computer.
2 Plug the square connector on the USB cable into the USB port on the back 

of the SOMAport. 
3 Plug the flat connector into the USB port on your computer. 

A hardware wizard window opens. 
20
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You will see the following message at the beginning of the installation: 
The software you are installing for this hardware: 
SOMAport USB (SOMAport.SYS)
has not passed Windows Logo testing to verify its 
compatibility with Windows.

Click Continue Anyway. The drivers have passed stringent internal testing by 
SOMA Networks, Inc. 

4 Follow the on-screen instructions in the wizard, making sure you select the 
values indicated in the following table for your version of Windows. 

5 Close the wizard windows and remove the CD from the drive. If prompted to 
do so, reboot your computer.

Version Selections

Windows 98 When prompted for the type of search, select Search 
for the best driver for your device.
When prompted for a location, select CD-ROM drive.
Insert the Windows 98 Second Edition CD if prompted.

Windows 2000 When prompted for the type of search, select Search 
for a suitable driver for your device.
When prompted for a location, select CD-ROM drives.

Windows ME When prompted for the type of search, select Specify a 
location.
When prompted for a location, select Removable 
Media.

Windows XP When prompted for the type of search, select Install 
the software automatically.
21
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CONNECT MULTIPLE COMPUTERS TO THE 
SOMAPORT

You can connect the SOMAport to an Ethernet hub, switch, or router 
device (referred to in the rest of this section as “hub” generically) in 
order to share the Internet connection among many computers. 

The SOMAport functions as a DHCP server (it automatically assigns IP 
addresses to devices attached to it). Consult the documentation for your 
hub for information about how to configure the hub and computers for 
Internet access via the SOMAport. 

To connect an Ethernet hub to the SOMAport
1 Insert one end of the straight-through Ethernet cable into the Ethernet port 

on the SOMAport. 
2 Insert the other end of the cable into an uplink port (sometimes labeled as a 

WAN or Internet port) on the hub. 
NOTE: If the Ethernet hub does not have an uplink port, you may connect to 
the SOMAport using an Ethernet port (which may be labeled as a switched, 
LAN, or numbered port) on the hub. However, you must obtain and use a 
crossover Ethernet cable (not shipped with the SOMAport) to make this 
connection.

3 Configure the hub and computers as required to access the Internet via the 
SOMAport.
22
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CONNECT TELEPHONES TO THE SOMAPORT

In order to use a telephone with your SOMAport, you will need to 
subscribe to your service provider’s telephone service during service 
activation. 

If telephone service is not available in your area or if you do not want to 
use telephones with your SOMAport, skip to “Activate Service” on 
page 27.

Telephone Jacks 
There are two telephone jacks on the back of the SOMAport, one for 
line 1 (bottom) and the other for line 2 (top). 

How you connect telephones to the SOMAport depends on three 
things:

The number of lines you subscribe to (one or two)

The number of telephones you connect to the SOMAport

The type of telephones you connect (one-line or two-line 
telephones) 

Lines
Connecting One 
Telephone

Connecting Two 
Telephones

One Use the line 1 (bottom) jack. 
See “To connect a single 
telephone” on page 24.

Insert a duplex adapter into the line 1 
(bottom) jack and then connect both 
telephones to the adapter. See “To 
connect two telephones (when you have 
one line)” on page 26.

Two Use the line 1 (bottom) jack. 
See “To connect a single 
telephone” on page 24. 

Connect telephones to both jacks. See 
“To connect two telephones (when you 
have two lines)” on page 25.
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To connect a single telephone
Insert the free end of the telephone cable into the line 1 (bottom) jack on the 
SOMAport.

NOTE: To connect a two-line telephone, you must subscribe to two lines.
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To connect two telephones (when you have two lines)
1 Connect the cable of the telephone you want serviced by line 1 to the line 1 

(bottom) jack on the SOMAport.
2 Connect the cable of the telephone you want serviced by line 2 to the line 2 

(top) jack on the SOMAport. 
NOTE: If you have a two-line telephone, connect it to the line 1 (bottom) 
jack.

Line 2

Line 1
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To connect two telephones (when you have one line) 
1 Insert a duplex adapter into the line 1 (bottom) jack of the SOMAport.
2 Insert the free end of one telephone cable into one of the jacks on the 

adapter.
3 Insert the free end of the second telephone cable into the other jack on the 

adapter. 

To test your SOMAport telephone service
Pick up the receiver and listen for dial tone. 

If you hear a standard dial tone, the SOMAport is connected to your service 
provider’s network. You may have to activate full service if your service 
provider hasn’t done so already. See “Activate Service” on page 27.

If you hear a series of tones, the SOMAport is still starting. Hang up, and 
listen again in a few minutes. 

If you hear silence, see “Finding Causes of Telephone Problems” on 
page 31.
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ACTIVATE SERVICE

After the SOMAport powers on, it will be in one of two service modes: 

Restricted access – Your SOMAport remains in this mode until 
your account is activated by your service provider. You can use the 
SOMAport only to contact your service provider to activate full 
service, either by telephone or through the service provider’s Web 
site. You cannot receive telephone calls in this mode, although you 
can place a call to an emergency service (for example, 911 in North 
America).

Full-service access – You can browse any site on the Internet, 
receive telephone calls, and place calls to any telephone number.

To activate full service
1 Restart your computer while it is connected to the powered-on SOMAport.
2 Launch a Web browser.
3 Direct your browser to a known valid Internet address (such as 

www.web.com).
If the page opens, full service has already been activated and you can begin 
using your SOMAport for Internet service.

If you are redirected to your service provider's Web page, complete the sign-
up procedure on the Web site to activate full service.

If you can not open any Web pages at all, see “Finding Causes of Computer 
Problems” on page 30.

NOTE: If you subscribe only to telephone service, activate full service by 
calling your service provider’s technical assistance center.
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This chapter describes the problems the SOMAport may exhibit, the 
possible causes of those problems, and the actions you should take to fix 
them.
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FINDING CAUSES OF COMPUTER PROBLEMS

Look up the problem you are experiencing and follow the suggested 
actions. If the recommended actions do not fix the problem, call your 
service provider.  

Problem Possible causes Action

You cannot 
connect to the 
Internet

Network settings for an Ethernet 
connection are incorrect.

See “Ethernet Network Settings are 
Incorrect” on page 41.

Signal has been dropped. Unplug the SOMAport and plug it back 
in again.

SOMAport is not receiving power. See “The SOMAport is Not Receiving 
Power” on page 34.

SOMAport experienced a fault 
condition during startup.

See “There is a Fault Condition” on 
page 33.

No connection between the 
computer and the SOMAport.

See “There is a Problem with the 
Ethernet or USB Cabling” on page 35.

You are using Internet Explorer and 
the LAN settings are not properly 
configured.

See “Internet Explorer LAN Settings 
are Incorrect” on page 40.

Signal is weak. See “The Signal is Weak” on page 32.

It takes a long 
time to open a 
Web page 

Internet congestion. Try again.

Signal is weak. See “The Signal is Weak” on page 32.

Cable connecting the computer to 
the SOMAport is damaged. 

Replace the cable.

Your network interface card (NIC) is 
in full-duplex mode. (This applies 
only if your SOMAport is directly 
connected to the NIC of your 
computer, rather than through a 
hub.)

Use the appropriate system control to 
change the duplex setting of your NIC 
to half-duplex. Refer to the 
documentation for your operating 
system.

Making a wireless 
Internet 
connection is 
prevented by old 
dial-up default

Computer is set up to connect to the 
Internet via dial-up by default.

See “The Computer Uses an Old Dial-
Up Connection” on page 38

You cannot send 
email

SMTP server associated with your 
existing email account is not 
accessible.

Use a Web account, such as yahoo, 
for sending and receiving messages.
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FINDING CAUSES OF TELEPHONE PROBLEMS

Look up the problem you are experiencing and follow the suggested 
actions. If the recommended actions do not fix the problem, call your 
service provider.

Problem Possible causes Action

Irregular dial tone If you hear a series of tones (not a 
regular dial tone) before you 
attempt a call, the SOMAport has 
not yet acquired a signal. 

Wait a few minutes and try again.

If you hear a “fast busy” tone after 
you attempt to dial a number, you 
are in restricted mode.

Activate full service as described in 
“Activate Service” on page 27.

No dial tone If your telephone is connected to 
line 2 and you hear silence before 
dialing a call, you are in restricted 
mode.

Activate full service as described in 
“Activate Service” on page 27.

Cable connections are not secure. Make sure the telephone cable is 
securely connected to the SOMAport 
and the telephone.

Telephone cable is inserted into the 
SOMAport’s 
Ethernet port. 

Make sure the telephone is connected 
to a telephone jack.

Telephone is broken. Try a telephone that is known to work. 
If you were using a cordless 
telephone, try using a corded one.

SOMAport experienced a fault 
condition during startup.

See “There is a Fault Condition” on 
page 33.

SOMAport is not receiving power. See “The SOMAport is Not Receiving 
Power” on page 34.

Signal is weak. See “The Signal is Weak” on page 32.

Voice quality is 
poor 

Signal is weak. See “The Signal is Weak” on page 32.

Telephone is broken. Try a telephone that is known to work. 
If you were using a cordless 
telephone, try using a corded one.

Calls are dropped Signal is weak. See “The Signal is Weak” on page 32.
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THE SIGNAL IS WEAK

The signal to your SOMAport may be weak if you are having any of the 
following problems: 

Telephone voice quality is poor or calls are dropped

It takes a long time to open a Web page

You cannot browse the Internet at all

To improve reception quality
1 Make sure you have located the SOMAport according to the guidelines 

listed in “Choose the Best Location” on page 17.
2 See if a nearby appliance is disrupting the signal. Do the following for each 

appliance, testing one appliance at a time:
i Turn off the appliance. 

ii While the appliance is off, check if the network performance improves. 

If there is an improvement, reposition either the appliance or the 
SOMAport so that they are farther apart. 

If there is no improvement, turn the appliance back on and try another 
appliance.

3 If you cannot improve reception in the SOMAport’s current location, try 
moving it to another location that meets the guidelines on page 17.

Persistent Reception Difficulties
Reception can be temporarily affected by severe weather conditions such 
as heavy storms, ice, or strong winds. Problems may persist in the 
absence of these conditions if:

There are obstructions—tall buildings, trees, or mountains—
between your SOMAport and the nearest communications tower. 

Your SOMAport is located at the outer limit of the coverage area.

Contact your service provider if you experience persistent signal 
reception difficulties.
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THERE IS A FAULT CONDITION 

If the status light is red, the SOMAport has detected a fault. In this 
situation, restart the SOMAport.   

To restart the SOMAport 
1 Unplug the SOMAport from the wall power outlet and wait at least 10 

seconds. 
2 Plug the SOMAport back in.
3 Wait until the status light on the front panel is green (an indication that the 

SOMAport is operating correctly). 
If the status light still indicates a problem, call your service provider.
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THE SOMAPORT IS NOT RECEIVING POWER

If the light on the power supply and the status light on the SOMAport 
are off, the SOMAport is not getting power. Try each of the actions in 
the following procedure until you locate the source of the problem. 

To check the power 
1 Make sure the power cord that connects the power supply to the wall outlet 

is securely connected to the power supply and the wall outlet.
2 Make sure the power cord that connects the power supply to the SOMAport 

is securely connected to the power jack on the back of the SOMAport.
3 Make sure the wall receptacle is working by plugging in an appliance that 

you know works.
4 Check the circuit breaker.
5 If you cannot find the source of the problem, call your service provider.
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THERE IS A PROBLEM WITH THE ETHERNET OR USB 
CABLING

If there is a problem with the physical connection between the 
SOMAport and your computer or hub, you will not be able to browse 
the Internet. 

Ethernet connection
There are two lights on the Ethernet port that indicate the status of the 
Ethernet connection: link (green), and data transmit (amber).

If the link light is off, the connection between the SOMAport and the 
Ethernet device is not working or does not exist.

The data transmit light flashes when data is being transmitted across the 
link. It is normal for this light to be off much of the time.

To check Ethernet cabling
1 Make sure the cable connectors are firmly inserted in the proper Ethernet 

ports on the SOMAport and computer or hub.   
2 Make sure you are using the correct type of cable:

3 Make sure the length of the cable does not exceed 100 meters (328 feet). 
4 If none of the previous steps solves the problem, replace the cable.

NOTE: You can replace the cable while the SOMAport is on. 

Configuration Cable Type Provided

Ethernet port of a computer Straight-through Yes

Uplink port of a hub Straight-through Yes

Ethernet port of a hub Crossover No
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USB connection
There is no link light on the USB port. If you are using USB to connect 
your computer to the SOMAport and you suspect there is a problem 
with the physical connection, check the USB cabling.

To check USB cabling
1 Make sure the cable connectors are firmly inserted in the proper USB ports 

on the SOMAport and the computer or hub. 
2 Make sure the length of the cable does not exceed 5 meters (15 feet).
3 If you are using a USB extension cable, check to see if it is faulty by 

removing the USB extension and using a single USB cable between the 
SOMAport and the computer. 
You may have to reposition the SOMAport to do this.

4 Replace the USB cable.
You can replace the cable while the SOMAport is on. 
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THERE IS A PROBLEM WITH THE USB PORT 
SETTINGS

If you are having problems getting the USB connection to work, ensure 
that your computer’s USB port is enabled and properly set up.

To check your PC’s USB port settings
1 Open the Control Panel:

In Windows 98 and 2000 and ME, choose Start→Settings→Control 
Panel.

In Windows XP, choose Start→Control Panel.

2 Double-click the System icon.
3 Open the Device Manager:

In Windows 98 and ME, click the Device Manager tab. 

In Windows 2000 or XP, click the Hardware tab and then click the Device 
Manager button.

4 Display devices by type:
In Windows 95 and 98 and ME, make sure the View devices by type radio 
button is enabled.

In Windows 2000 and XP, select View→Devices by type.

5 Click the plus (+) icon next to the Universal Serial Bus controller option.
If the following drivers are listed, USB is enabled and you can use the USB 
port: 

USB Host Controller

USB Root Hub

If these drivers are not listed, there are two possible reasons: 

You have a USB Host Controller installed in your PC, but the USB port is 
not enabled. See your computer’s documentation for instructions on how to 
run your computer’s BIOS Setup program to enable the USB port.

You do not have a valid USB Host Controller installed in your PC. You 
cannot use USB until you install a valid USB Host Controller. 
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THE COMPUTER USES AN OLD DIAL-UP 
CONNECTION

If you switched from a dial-up Internet service when you subscribed to 
wireless SOMAport Internet service, you may still be prompted to 
connect to the Internet using the old dial-up connection. If this is the 
case, use the procedure in this section appropriate to your operating 
system to ensure that your dial-up connection is not automatically 
activated whenever you attempt to connect to the Internet. 

To disable the automatic dial-up connection in Windows
1 Open the Control Panel.

In Windows XP, choose Start→Control Panel.

In all other versions of Windows, choose Start→Settings→Control Panel.

2 Double-click the Internet Options icon.
The Internet Properties window opens.

3 Click the Connections tab.
4 Enable the Never dial a connection checkbox.
5 Click OK.

NOTE: If you still cannot display a Web page, check your browser to make 
sure it is in online mode. 

To disable the automatic dial-up connection in Mac OS 8 and 9
1 Click the Apple icon and choose Control Panels.
2 Click Remote Access. 
3 Click Options. 
4 Click the Protocol tab. 
5 Make sure the Connect automatically when starting TCP/IP applications 

box is disabled. 
6 Click OK.
7 Choose File→Quit. 
8 Click Save when prompted to save the current configuration.
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To disable the automatic dial-up connection in Mac OS X
1 Click the Apple icon and choose System Preferences.
2 Click the Network icon. 
3 Click Show.
4 Select Network Port Configurations from the pull-down list. 
5 Disable the On checkbox for the dial-up modem.
6 Click Apply Now. 
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INTERNET EXPLORER LAN SETTINGS ARE 
INCORRECT

If you are using Internet Explorer as your Web browser, make sure it is 
configured to automatically detect LAN settings. If this default setting 
has been disabled, you will not be able to connect to the Internet. 

To check Internet Explorer settings
1 Open Internet Explorer.
2 Choose Tools→Internet Options.

The Internet Options window opens.

3 Click the Connections tab.
4 Click LAN Settings.

The Local Area Network (LAN) Settings window opens.

5 Make sure the Automatically detect settings checkbox is enabled.
6 Click OK.
7 Click OK on the Internet Options window.
8 Close Internet Explorer.
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ETHERNET NETWORK SETTINGS ARE INCORRECT

If you could not get an Internet connection after connecting your 
computer to the SOMAport via Ethernet, but your physical connection 
seems to be intact, your computer’s Ethernet network settings may need 
to be changed. 

Use the procedure in this section appropriate to your operating system 
to reconfigure Ethernet network settings. You may be prompted to 
insert the installation CD for your operating system, and you may need 
to reboot your computer after changing the settings before you can 
successfully connect to the Internet.

To change network settings in Windows 95 
1 Choose Start→Settings→Control Panel.
2 Double-click the Network icon.

The Network window opens to the Configuration tab.

3 Select TCP/IP.
If multiple TCP/IP connections are listed, select the one that contains 
“Ethernet”, “NIC”, or “10/100 MB” in its name. Go to step 5.

If TCP/IP is not listed, go to step 4.

4 Install TCP/IP:
i Click Add.

The Select Network Component Type window opens.

ii Select Protocol from the list. 

iii Click Add.

The Select Network Protocol window opens.

iv Select Microsoft from the Manufacturers list.

v Select TCP/IP from the Network Protocols list.

vi Click OK.

vii Insert the Windows 95 CD or reboot the computer if prompted to do so. 

viiiIf the PC reboots, repeat steps 1 to 3, then go to step 5.
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5 Check the TCP/IP properties:
i Click Properties.

The TCP/IP Properties window opens to the IP Address tab.

ii Make sure the Obtain an IP address automatically radio button is 
enabled.

iii Click the DNS Configuration tab.

iv Enable the Disable DNS radio button.

v Click OK on the TCP/IP Properties window.

vi Click OK on the Network window.

vii Restart the computer if prompted to do so.

6 Check your Internet connection by launching a Web browser on the 
computer connected to the SOMAport.

If your browser automatically opens to your service provider’s Web site, 
activate full service by following the sign-up procedure that is provided on 
the Web site.

If your browser does not automatically open to your service provider’s Web 
site, go to step 7.

7 Enter a valid Internet address (such as www.web.com) in the Address field 
and press Enter.

If the Web page opens, full service has already been activated and you can 
begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 
the sign-up procedure that is provided on the Web site.

If your computer attempts to connect to the Internet using an old dial-up 
connection, see “The Computer Uses an Old Dial-Up Connection” on 
page 38.

If you do not get an Internet connection, see “Finding Causes of Computer 
Problems” on page 30.
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To change network settings in Windows 98 and ME 
1 Choose Start→Settings→Control Panel.
2 Click the Network icon.

The Network window opens to the Configuration tab.

3 Select TCP/IP. 
If multiple TCP/IP connections are listed, select the one that contains 
“Ethernet”, “NIC”, or “10/100 MB” in its name. Go to step 4.

If TCP/IP is not listed, install it:

i Click Add.

The Select Network Component Type window opens.

ii Select Protocol from the list. 

iii Click Add.

The Select Network Protocol window opens.

iv Select Microsoft from the Manufacturers list.

v Select TCP/IP from the Network Protocols list.

vi Click OK.

vii Insert the Windows 98 or ME CD or reboot the computer if prompted to 
do so. 

viii If the PC reboots, repeat steps 1 to 3.

4 Check TCP/IP properties:
i Click Properties with the correct TCP/IP connection selected.

The TCP/IP Properties window opens to the IP Address tab.

ii Make sure the Obtain an IP address automatically radio button is 
enabled.

iii Click the DNS Configuration tab.

iv Make sure the Disable DNS radio button is enabled.

v Click OK on the TCP/IP Properties window.

vi Click OK on the Network window.

vii Restart the computer if prompted to do so.

5 Check your Internet connection by launching a Web browser on the 
computer connected to the SOMAport.
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If your browser automatically opens to your service provider’s Web site, full 
service has already been activated and you can begin using your SOMAport 
for Internet service. 

If your browser does not automatically open to your service provider’s Web 
site, go to step 6.

6 Enter a valid Internet address (such as www.web.com) in the Address field 
and press Enter.

If the Web page opens, full service has already been activated and you can 
begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 
the sign-up procedure that is provided on the Web site.

If your computer attempts to connect to the Internet using an old dial-up 
connection, see “The Computer Uses an Old Dial-Up Connection” on 
page 38.

If you do not get an Internet connection, see “Finding Causes of Computer 
Problems” on page 30.

To change network settings in Windows 2000 
1 Right-click the My Network Places icon and choose Properties from the 

pull-down menu. 
The Network and Dial-up Connections window opens.

2 Select the Local Area Connection icon.
If there are multiple local area connections, read the device name beside 
each icon and double-click the one that is associated with the Ethernet card. 

If there is no icon, the Ethernet card has not been properly installed. Install 
the Ethernet card by following the manufacturer’s instructions, then return to 
this procedure. 

The Local Area Connection Status window opens.

3 Click Properties.
The Local Area Connection Properties window opens. 

4 Select Internet Protocol (TCP/IP).
If Internet Protocol (TCP/IP) is not listed, install it as follows:

i Click Install.

The Select Network Component Type window opens.
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ii Select Protocol from the list. 

iii Click Add.

The Select Network Protocol window opens.

iv Select Internet Protocol (TCP/IP).

v Click OK.

vi Insert the Windows 2000 CD or reboot the computer if prompted to do so.

vii If the PC reboots, repeat steps 1 to 4.

5 Check TCP/IP properties:
i Click Properties.

ii The Internet Protocol (TCP/IP) Properties window opens to the General tab.

iii Make sure the Obtain an IP address automatically radio button is 
enabled.

iv Make sure the Obtain DNS server address automatically radio button is 
enabled.

v Click OK on the Internet Protocol (TCP/IP) Properties window.

vi Click OK on the Local Area Connection Properties window.

vii Click Close on the Local Area Connection Status window.

viiiRestart the computer if prompted to do so.

6 Check your Internet connection by launching a Web browser on the 
computer connected to the SOMAport.

If your browser automatically opens to your service provider’s Web site, full 
service has already been activated and you can begin using your SOMAport 
for Internet service. 

If your browser does not automatically open to your service provider’s Web 
site, go to step 7.

7 Enter a valid Internet address (such as www.web.com) in the Address field 
and press Enter.

If the Web page opens, full service has already been activated and you can 
begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 
the sign-up procedure that is provided on the Web site.
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If your computer attempts to connect to the Internet using an old dial-up 
connection, see “The Computer Uses an Old Dial-Up Connection” on 
page 38.

If you do not get an Internet connection, see “Finding Causes of Computer 
Problems” on page 30.

To change network settings in Windows XP 
1 Choose Start→Settings→Network Connections.

The Network Connections window opens.

2 Select the Local Area Connection icon.
If there are one or more Local Area Connection icons, double-click the 
Local Area Connection icon that is associated with the Ethernet card.

If there is no icon, the Ethernet card has not been properly installed. Install 
the Ethernet card by following the manufacturer’s instructions, then return to 
this procedure. 

The Local Area Connection Status window opens.

3 Click Properties.
The Local Area Connection Properties window opens. 

4 Select Internet Protocol (TCP/IP).
If Internet Protocol (TCP/IP) is not listed, install it as follows:

i Click Install.

The Select Network Component Type window opens.

ii Select Protocol from the list. 

iii Click Add.

The Select Network Protocol window opens.

iv Select Internet Protocol (TCP/IP).

v Click OK.

vi Insert the Windows XP CD or reboot the computer if prompted to do so.

vii Once TCP/IP has been installed, repeat steps 1 to 4.

5 Check TCP/IP properties:
i Click Properties.

The Internet Protocol (TCP/IP) Properties window opens to the General tab.
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ii Make sure the Obtain an IP address automatically radio button is 
enabled.

iii Make sure the Obtain DNS server address automatically radio button is 
enabled.

iv Click OK on the Internet Protocol (TCP/IP) Properties window.

v Click OK on the Local Area Connection Properties window.

vi Click Close on the Local Area Connection Status window.

vii Restart the computer if prompted to do so.

6 Check your Internet connection by launching a Web browser on the 
computer connected to the SOMAport.

If your browser automatically opens to your service provider’s Web site, full 
service has already been activated. 

If your browser does not automatically open to your service provider’s Web 
site, go to step 7.

7 Enter a valid Internet address (such as www.web.com) in the Address field 
and press Enter.

If the Web page opens, full service has already been activated and you can 
begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 
the sign-up procedure that is provided on the Web site.

If your computer attempts to connect to the Internet using an old dial-up 
connection, see “The Computer Uses an Old Dial-Up Connection” on 
page 38.

If you do not get an Internet connection, see “Finding Causes of Computer 
Problems” on page 30.

To change network settings in Mac OS 8 and 9
NOTE: Your computer must have an Ethernet card and Open Transport 
networking software to connect to the Internet. 

1 Click the Apple icon and choose Control Panels→TCP/IP.
The TCP/IP window opens.

2 Select Ethernet from the Connect via pop-up menu.
3 Select Using DHCP Server from the Configure pop-up menu.
4 Close the TCP/IP control panel.
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If you made any changes, save them when prompted.

5 Restart your computer.
6 Check your Internet connection by launching a Web browser on the 

computer connected to the SOMAport. 
If your browser automatically opens to your service provider’s Web site, full 
service has already been activated. 

If your browser does not automatically open to your service provider’s Web 
site, go to step 7.

7 Enter a valid Internet address (such as www.web.com) in the Address field 
and press Enter.

If the Web page opens, full service has already been activated and you can 
begin using your SOMAport for Internet service.

If your service provider’s Web page opens, activate full service by following 
the sign-up procedure that is provided on the Web site.

If you do not get an Internet connection, see “Finding Causes of Computer 
Problems” on page 30.

To change network settings in Mac OS X
1 Click the Apple icon and choose System Preferences.   
2 Choose View→Network.
3 Choose Built-in Ethernet from the Show pop-up menu.
4 Click the TCP/IP tab, if necessary.
5 Choose Using DHCP from the Configure pop-up menu.
6 Click Apply Now.
7 Restart your computer.
8 Check your Internet connection by launching a Web browser on the 

computer connected to the SOMAport.
If your browser automatically opens to your service provider’s Web site, full 
service has already been activated. 

If your browser does not automatically open to your service provider’s Web 
site, go to step 9.

9 Enter a valid Internet address (such as www.web.com) in the Address field 
and press Enter.

If the Web page opens, full service has already been activated and you can 
begin using your SOMAport for Internet service.
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If your service provider’s Web page opens, activate full service by following 
the sign-up procedure that is provided on the Web site.

If you do not get an Internet connection, see “Finding Causes of Computer 
Problems” on page 30.
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IP ADDRESS NEEDS TO BE RENEWED

If you cannot connect to the Internet even after you have checked all 
cabling and network settings and have rebooted the computer, follow 
the appropriate procedure in this section to manually obtain a new IP 
address.

To obtain a new IP address (Windows 95 only) 
1 Choose Start→Run.    
2 Enter winipcfg in the Open field and click OK. 

The IP Configuration window opens.

3 Select the network interface that has a default gateway of 192.168.1.1 from 
the pull-down list. 

4 Click Release All.
5 Force your computer to obtain a new IP address by clicking Renew All.

Wait until the fields in the IP Configuration window have values in them or an 
error message appears. If you close this program before it has completed its 
task, you will have to reboot your computer before you can use your Internet 
service. 

6 Close the IP Configuration window.
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To obtain a new IP address (all other versions of Windows) 
1 Open a command window using one of the following methods:

In Windows 2000 or XP, choose 
Start→Programs→Accessories→Command Prompt.

In Windows 98 or ME, choose Start→Programs→MS-DOS Prompt.

The command window opens.

2 Force your computer to obtain a new IP address by typing the appropriate 
command from the following table: 

The Windows IP configuration is displayed.

3 Look for the output section related to the network interface for the 
SOMAport. 
Example:   

Ethernet adapter:
IP address . . . . . . . . . . . . .  : 65.94.64.155
Subnet Mask . . . . . . . . . . . . . : 255.255.255.0
Default Gateway . . . . . . . . . . . : 192.168.1.1

4 Close the MS-DOS Prompt or Command Prompt window.    

Operating system Command

Windows 98 or ME ipconfig /renew_all ↵

Windows 2000 or XP ipconfig /renew ↵
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Release SOMAport R3.0

Internal antenna Type: internal passive-steered array antenna
Internal antenna gain: 3 dBi
Receiver noise figure: 6 dB
Transmitted EIRP: 30 dBm
RF output power: 27 dBm

Device ports and 
interfaces

Telephone
Jacks: 2 RJ-11 telephone jacks
Max REN per jack: 5
Max REN per SOMAport: 5 REN simultaneous, 10 REN interleaved
Data
Ethernet (RJ-45, 10Base-T), USB (type “B”, 1.1)

Lights Network, status

Power requirements Power Supply
Type: U.S./International 120/230V AC–DC external power supply
Cable: Power cord with non-wall-mounted AC-to-DC transformer

Environmental 
specifications

Temperature
Operating: +5ºC to +40ºC (+41ºF to +104ºF) (without fan)
Storage: –20ºC to +65ºC (–4ºF to +149ºF)
Humidity
Operating: 20%–95%, noncondensing
Storage: 5%–95%, noncondensing
Altitude
Operating: 2438 m (8000 feet)

Packaging Dimensions
Height: 14 cm (5.5 inches)
Width: 7 cm (2.8 inches)
Depth: 19 cm (7.5 inches)
Weight: 0.85 kg (1.9 pounds)
Volume: 1700 cc (104 cubic inches)

Regulatory 
certifications

CE
MET, MET-c
IEC 60950-1
FCC Part 15B, Part 24 (PCS Only)
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A
activating full service 27
antenna 14

improving signal reception 17

B
back panel 13

C
cables

crossover 35
Ethernet 35
problems and actions 30, 31
USB 36

calls
are dropped 31

computer equipment
connecting to a SOMAport

using the Ethernet port 19
using the USB port 20

connecting
an Ethernet hub 22
computer equipment

using the Ethernet port 19
using the USB port 20

multiple computers 22
power supply 18
telephones 23

connection problem 36
connectors

Ethernet 13
USB 13

D
dial tone

none 31
dial-up connection

disabling 38

disconnecting power supply 18

E
Ethernet

cables 22, 35
hub 22
network settings

Mac OS X 48
Windows 2000 44
Windows 95 41
Windows 98 and ME 43
Windows XP 46

port 13

F
fault conditions 33
front panel 11
full service

activating 27

H
hub. See Ethernet and LANs

I
Internet 30

access problems 32
access to LAN PCs 22
cannot connect to 30
disabling dial-up connection 38

Internet Explorer
detecting LAN settings 40

IP address
obtaining automatically

Mac OS X 48
Windows 2000 44
Windows 95 41
Windows 98 and ME 43
Windows XP 46
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renewing in Windows 50–51

J
jacks. See telephone jacks and power
jack

L
LANs

Internet access to PCs 22
Internet Explorer settings 40
See also Ethernet

lights
link 36
network 12
status 12

M
Mac OS X

network settings 48
multiple computers

connecting 22

N
network light 12
network settings

changing
Mac OS X 48
Windows 2000 44
Windows 95 41
Windows 98 and ME 43
Windows XP 46

Windows 95 41

P
performance

optimizing 17
problem causes 32

ports 13
Ethernet 13
USB 13

power jack 13
power requirements 53
power supply

checking 34

connecting 18
disconnecting 18

powering on the SOMAport 18
problems

Internet connection 30

R
radio signals. See signals
reception quality 17
restarting

SOMAport 33
restricted access 27

S
safety instructions 5, 14
safety warnings 5
separation distance 14
service modes 27
service providers 10
services

activating 27
servicing. See SOMAports
settings

Internet Explorer 40
 See also network settings

signals
causes of weak signal 32
reception quality 17
strength levels 12

SOMAports
connecting Ethernet hubs 22
maintenance and servicing 6
optimizing performance of 17
parts shipped 16
performance problems 32
powering on 18
restarting 33
signal strength 32

status light
states 12

T
telephone

checking 26
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poor voice quality 31
telephone calls

are dropped 31
telephone jacks 13, 23
testing

telephone connection 26
two-line telephones 23

U
unpacking 16
USB

checking the cable 36
installing drivers 21
port 13
troubleshooting 36
when to use 19

V
voice quality 31

W
warnings 5
Web pages. See Internet
Windows 2000

network settings 44
Windows 95

network settings 41
Windows 98 and ME

network settings 43
Windows XP

network settings 46
wireless service provider 10
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